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License Agreement
1. License. The application, demonstration, system and other software 
accompanying this License, whether on disk, in read-only memory, or by any other 
media (the “Software”) and the related documentation are licensed to you by 
Catamount Software. You own the media on which the Software is recorded but 
Catamount Software and/or Catamount Software’s Licenser(s) retain title to the 
Software and related documentation. This License allows you to use the Software 
on a single Palm Computing Device, and make one copy of the Software in machine-
readable form for backup purposes only. You must reproduce on such copy 
Catamount Software’s copyright notice and any other proprietary legends that 
were on the original copy of the Software. You may also transfer all your license 
rights in the Software, the backup copy of the Software, the related documentation 
and a copy of this License to another party, provided the other party reads and 
agrees to accept the terms and conditions of this License.

2. Restrictions. The Software contains copyrighted material, trade secrets and 
other proprietary material and in order to protect them, you may not decompile, 
reverse engineer, disassemble or otherwise reduce the Software to a human-per-
ceivable form. You may not modify, network, rent, lease, loan, distribute or create 
derivative works based upon the Software in whole or in part.

3. Termination. This License is effective until terminated. You may terminate this 
License at any time by destroying the Software and related documentation. This 
License will terminate immediately without notice from Catamount Software if 
you fail to comply with any provision of this License. Upon termination you must 
destroy the Software and related documentation.

4. Export Law Assurances. You agree and certify that neither the Software nor any 
other technical data received from Catamount Software, nor the direct product 
thereof, will be exported outside the United States except as authorized and as 
permitted by the laws and regulations of the United States. If the Software has 
been rightfully obtained by you outside of the United States, you agree that you 
will not re-export the Software nor any other technical data received from 
Catamount Software, nor the direct product thereof, except as permitted by the 
laws and regulations of the United States and the laws and regulations of the 
jurisdiction in which you obtained the Software.

5. Government End Users. If you are acquiring the Software on behalf of any unit 
or agency of the United States Government, the following provisions apply. The 
Government agrees: (i) if the Software is supplied to the Department of Defense 
(DoD), the Software is classified as “Commercial Computer Software” and the 
Government is acquiring only “restricted rights” in the Software and its 
documentation as that term is defined in Clause 252.227-7013(c)(1) of the DFARS; 
and (ii) if the Software is supplied to any unit or agency of the United States 
Government other than the DoD, the Government’s rights in the Software and its 
documentation will be as defined in Clause 52.227-19(c)(2) of the FAR or, in the 
case of NASA, in Clause 18-52.227-86(d) of the NASA Supplement to the FAR.

6. Disclaimer of Warranty on Software. You expressly acknowledge and agree that 
use of the Software is at your sole risk. The Software and related documentation 
are provided “AS IS” and without warranty of any kind and Catamount 
Software and Catamount Software’s Licenser(s) (for the purposes of provisions 6, 
Catamount Software and Catamount Software’s Licenser(s) shall be collectively 
referred to as “Catamount Software”) EXPRESSLY DISCLAIM ALL 
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WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. Catamount Software DOES NOT WARRANT THAT 
THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE 
SOFTWARE WILL BE CORRECTED. FURTHERMORE, Catamount Software 
DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING 
THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR RELATED 
DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, 
RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY Catamount Software OR AN AUTHORIZED 
REPRESENTATIVE OF Catamount Software SHALL CREATE A WARRANTY 
OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD 
THE SOFTWARE PROVE DEFECTIVE,YOU (AND NOT Catamount Software 
OR AN AUTHORIZED REPRESENTATIVE OF Catamount Software) ASSUME 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION IF 
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO 
YOU.

7. Limitation of Liability.UNDER NO CIRCUMSTANCES INCLUDING 
NEGLIGENCE, SHALL Catamount Software BE LIABLE FOR ANY 
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES THAT RESULT 
FROM THE USE OR INABILITY TO USE THE SOFTWARE OR RELATED 
DOCUMENTATION, EVEN IF Catamount Software OR AN AUTHORIZED 
REPRESENTATIVE OF Catamount Software HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW 
THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU. In no event shall Catamount 
Software’s total liability to you for all damages, losses, and causes of action 
(whether in contract, tort (including negligence) or otherwise) exceed the amount 
paid by you for the Software.

8. Controlling Law and Severability. This License shall be governed by and 
construed in accordance with the laws of the United States and the State of 
Vermont, as applied to agreements entered into and to be performed entirely 
within Vermont between Vermont residents. If for any reason a court of competent 
jurisdiction finds any provision of this License, or portion thereof, to be 
unenforceable, that provision of the License shall be enforced to the maximum 
extent permissible so as to effect the intent of the parties, and the remainder of this 
License shall continue in full force and effect.

9. Complete Agreement. This License constitutes the entire agreement between the 
parties with respect to the use of the Software and related documentation, and 
supersedes all prior or contemporaneous understandings or agreements, written 
or oral, regarding such subject matter. No amendment to or modification of this 
License will be binding unless in writing and signed by a duly authorized 
representative of Catamount Software.
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1. 
Introduction

Thank you for purchasing the powerhouse of Palm OS finance programs 
– PocketMoney. PocketMoney was designed to do one thing and do it 
very well – track your finances quickly with the smallest amount of 
work.

PocketMoney tracks finances for you, but you might have other Palm OS 
programs that do things better than PocketMoney can - like tracking 
upcoming bills, tracking business expenses, calculating the tip at 
restaurants, or tracking car expenses. Why are we talking about other 
programs? Well these programs handle your money, too - like the $20 
you spent on gas to fill up your Range Rover. MPG will figure out your 
Range Rover is only getting 14 miles per gallon and that you put $1000 
worth of fuel in it for the year, but you shouldn’t have to enter the $20 
into your finance program again...so MPG and PocketMoney work 
together to track your finances quickly with the smallest amount of 
work. PocketMoney has an open standard that the above programs 
support. This standard allows MPG to save that $20 gas purchase to 
PocketMoney with just two taps of the stylus.

PocketMoney has a few reports which most users will find adequate, 
but for the financial power users, PocketMoney also gives you a way to 
create complicated financial reports. For this task, PocketMoney lets 
you export to your desktop finance program, spreadsheet or database. 
Upload PocketMoney data to most desktop applications, and from the 
desktop create the color graphs, P&Ls, balance sheets, cash flow 
reports, and integrated QuickTime movies of your dreams.
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Know your Palm Computing Device
This manual assumes that you are already familiar with basic Palm 
OS operation including:

• Writing and editing.

• Accessing and using the keyboard.

• Launching applications.

• The Up and Down scroll buttons.

If not, consult your Palm Computing Device User Manual before you 
proceed.

What’s Included
You will find the following files on the PocketMoney disk or in the 
archive (.zip or .sit):

• PocketMoney .prc - the PocketMoney application.

• Readme.txt - contains late-breaking information on this version of 
PocketMoney.

• PocketMoney Conduit - allows uploading and downloading of data 
to Quicken, MS Money and other finance programs via QIF files or 
to a spreadsheet and database via TDF files.

Use Stuffit Expander for Macintosh or Windows to uncompress the .zip 
or .sit.hqx files.  http://www.aladdinsys.com/

Installing PocketMoney
Refer to the documentation that came with your Palm Computing 
Device for instructions on installing software.

PocketMoney User’s Manual v.3.0 2



Purchasing PocketMoney
There are several ways to purchase PocketMoney. 

• Credit Card Online - Kagi processes credit card payments for 
Catamount Software. Go to <http://order.kagi.com/?HM> if you 
have a credit card and want to pay online. This is typically the 
fastest way to pay for the software. It still takes a few days for me 
to turn around your registration code.

• Cash - I’ll accept cash payments in any currency that is equivalent 
to the current price of PocketMoney. Send to address below.

• Checks/Cheques - I can only accept US checks and Canadian 
cheques. Canadian cheques need to take into account the current 
exchange rates.

• International Postal Money Orders - I can accept IPMOs. They are 
usually  inexpensive to purchase.

Mail payments to:
Catamount Software
PO Box 8276
Essex VT 05451, USA
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Registering PocketMoney

The registration code is based on your 
device’s HotSync name. This is mostly 
likely your name. I will email a code to 
you. Enter it in the Registration Code 
field on the About PocketMoney screen 
accessed  from the Options menu.
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Hi n t :
H int :

2.
Basics

This chapter covers basic PocketMoney transaction operations and 
screens. Refer to “Features” for full coverage of all of PocketMoney’s 
features.

Opening PocketMoney on Palm OS

To access PocketMoney, simply:

• Tap Applications then tap PocketMoney.

Set a hard button in the Palm’s Prefs to PocketMoney so it can be 
quickly accessed.

Accounts

You may create as many accounts as needed in the Account screen by 
tapping the New button (See Account Prefs” for more information). 
Accounts that represent your assets (checking, savings, and petty cash) 
normally have a positive balance. Accounts that represent liabilities 
(i.e., money you owe), such as credit cards, normally have a negative 
balance, until you pay them off. With this representation, a 
calculation of your net worth, for example, would simply be a sum of the 
balances in all the accounts.
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Account Info
Button

Cleared,
Running,
Absolute Balance

Total Worth

Total Worth
Checkbox

Shortcut #1

Shortcut
 #2

• Account Info Button - opens the Account Info screen. The Account Info 
screen sets general information about the account and is where you 
access the Delete button to delete the account.

• Total Worth Checkbox - check this box to add the account into the 
total worth calculation. This can be turned on in the Account Info 
screen by checking Total Worth Calculation.

• Cleared/Balance - pop-up to display either the cleared balance, 
running balance or the absolute balance for the accounts. The 
running balance is the balance of the account as of the current date 
and time so repeating transactions that are entered in advance of 
paying them are not included in the running balance.

• Total Worth - the sum of the balances of all of the accounts 
displayed which have Total Worth Calculation turned on.

•  New - button creates a new accounts.

•  Shortcut 1 - to quickly create a new transaction in an account 
without opening the register tap on the balance of the account.

•  Shortcut 2 - to view all transactions for all accounts tap the 
Account label .
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Accessing a particular Account Register

To access the corresponding Register  from the Account Screen, simply 
tap the account name.

Transactions

PocketMoney provides three types of transactions using the Data Entry 
Slip:

• Deposit - from sources outside PocketMoney. Deposits are any 
transactions that increase your net worth, such as depositing your 
paycheck into checking, or depositing an inheritance from Aunt 
Gertrude into your savings account.

• Withdrawal - to payees outside PocketMoney. Withdrawals are any 
transactions that decrease your net worth, such as writing a check for 
your electric bill, spending $10 at the movies, or using your credit card 
to purchase a new snowboard.

• Transfer - from one PocketMoney account to another. Transfers do not 
change your net worth because money is just being moved between 
accounts. Examples include withdrawing cash with your ATM card 
(into Petty Cash), or writing a check to pay your credit card.

Note: Transfer transactions are saved as two separate entries; one 
transaction for the transfer from account and one transaction for the 
transfer to account. Any modifications made to one half of the transfer 
are made intelligently to the second half.
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Data Entry Screen

The Data Entry Screen looks similar to this for Deposit, Withdrawal, 
and Transfer transactions:

Tips

Transaction Type

Exchange Rate (only visible
if multiple currencies is
selected in Prefs)
Balance or Cleared Balance

Class / Folder

Memo/NotesDelete

Cleared
Amount

Include Fee/
New Check #

Search NamesPayee
Category/Splits

Account
Date/Time

Save

Don't Save

Repeating Tranaction
Button

It includes the following elements:

• Transaction Type - either Deposit,Withdrawal, or Transfer. 

• Date/Time - the date & time that the transaction took place. Tap 
on the date or time to pop-up change the date/time. Transactions 
are listed by Date, so by modifying the date/time you can reorder 
the way checks are listed.

• Repeating Transaction Button - opens the repeating transaction 
setup screen. If the box is darkened then the transaction is a 
repeating transaction. 

• Account - the name of the account that you are tracking (e.g., 
checking, credit card, or any other one that you have created). Tap 
on the Account  picker to select an account for the transaction.

• Category - allows you to organize your transactions into categories 
such as Salary or Interest. Write or key in a name or tap on the 
Category  to select a category for the transaction or to access the 
List Editor. (See “Category Splits” for further information).
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Hi n t :

• Payee (To/From/Trans To/Trans From) -generally referred to as 
the Payee field; this label is based on the transaction type. “To” is 
displayed for Withdrawal, “From” is displayed for Deposit,“T 
To” and “T From” are displayed for Transfer To and From. Write or 
key in a name or tap on the  to pop-up the List Editor to choose a 
predefined source for the transaction or to add a new source. The 
pop-up list of choices is dependent upon the Category. For example, 
if the Category is food, only places from where you purchase food 
are displayed. You must pick the Account to transfer to from the 
pop-up list for Transfers. This field is two lines so that long names 
can be entered.

Activate “Auto-add categories and payees” in Prefs to save time 
editing the pop-up list.

•  Search Names Button - is a shortcut to entering name or company 
information that exists in the Address List.  is not displayed for 
Transfers.

• Amount - the amount of the transaction. Tap  to pick from some 
common amounts (e.g. $100, $50). Edit this list to suit your needs 
with the List Editor.

• Exchange Rate - the foreign currency exchange rate. Rate is 
displayed if “Multiple Currencies” is checked in Prefs (See 
“Preferences” for more information). Enter Amount and exchange 
rate corresponding to 1 unit of your base currency. For example, if 
you receive a $20 Canadian payment, then you enter $20 in Amount, 
and enter 1.33 in Rate. 1.33 Canadian dollars is equal to 1 US 
dollar. 

Note: The exchange rate is saved on a transaction by transaction basis. This allows 
you to edit the rate after you receive your credit card statement to reflect the actual 
exchange rate that your credit card company used.
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3.5!

• Id # - check number or any other identifier you want in this field. 
The pop-up list gives you two options:

•!New Check # - PocketMoney searches old entries to find the next 
available check number. If you want to put ATM transaction 
numbers into the Id # field, you should prefix the number with 
“ATM” or some other text to distinguish non-check numbers from 
check numbers.

•!Include Fee - PocketMoney adds a separate transaction for the 
default fee set by the user in Account Prefs (see Accounts Prefs for 
more information). No fee transaction is added if the default fee 
amount value is 0 or blank.

  New Check#  (#101) and Include Fee ($) can be quickly accessed by 
in Pal mOS 3.5 by drawing the shortcut stroke and tapping the 
appropriate button.

• Cleared - a check in this box means that the transaction has 
cleared the bank. Use this to reconcile your bank statement.

• Balance - the balance of the account, after the transaction is made. 
Tap on the Balance label to change the display setting. The 
choices are Balance, Cleared Balance, and Running Balance.

• Memo/Notes/Description - Several lines of additional information 
of your choice about the transaction.

• Folder/Class - the folder that the current transaction is filed in. 
By default, this is “Unfiled”. Use folders to keep your personal 
finances separate from your business finance for expense reporting. 
Folders are exported as Quicken classes. The Palm OS limits the 
maximum number of folders to 15.

PocketMoney User’s Manual v.3.0 10



Register Screen

The Register screen provides a list of  transactions. Register is the 
easiest way for a quick look at all your data, for fast access to a specific 
transaction, and for clearing a large number of transactions quickly.

Folder

Cleared Checkboxes

Column Headings
Account Name

Cleared

Scrol ler

Cleared/Balance

New Transaction

• Account Name - the name of the account that you are viewing. This 
will be set to “All Accounts” if you have chosen “All Transactions” 
in the View Menu or you set Account to “All Accounts” in a Custom 
Filter. 

• Column Headings - Tapping  toggles cleared filter setting. The 
middle column ( Payee) can display different fields of the 
transactions. [Account/Category, Account/Payee, Category, 
Category/Payee, ID# Payee, Memo, Payee].  Tapping Amount 
toggles the Transaction Type filter setting: - withdrawal, + 
deposit, = transfer,  repeating transfers, and blank for all.

• Cleared - a check in this box means that the transaction has 
cleared the bank. Tap the checkbox to mark a transaction as 
cleared. Use this to reconcile your bank statement.

• Balance - the balance of the account, after the transaction is made. 
Tap on the Balance label to change the display setting. The 
choices are Balance and Cleared Balance.

• New - tap this button to create new transaction.

• OK - tap this button to return to the Account Screen.
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Accessing a particular Data Entry Slip

To access the corresponding Data Entry Slip from the Register Screen, 
simply tap the desired transaction.

Note: If you are viewing All Transactions then there are two overview 
items for each transfer transaction.

Menus

Tap the Menu button  to access the menus in PocketMoney. 
Depending on what screen you are in will determine what menu is 
displayed. 

Options

• Recompute Balances - recalculates all your account balances if you 
modify your PocketMoney data via third party software. (See 
“Recompute Balances” for further information).

• IR Sync - synchronize transactions to PocketMoney on another 
Palm. (See “HotSync Scenarios” for further information).

• Reset IR Sync - resets the last sync time and user.

• Preferences - opens the PocketMoney Preferences screen, allowing 
you to change the default behavior of some features. (See 
“Preferences” for further information).
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• Set Row Color... - select the row color for the account register or for 
the account list. Turn this option on in the Preferences by checking 
“Use Color Banding in Register”. 

Note: Setting the row color to black for the account list screen will 
display  the rows in the color set for each individual account register.

• Font... - displays the Select Font window. The register and account 
list tables are displayed in the user selected font.

• Rotate... - own a Handera 330 or other device that can rotate the 
screen? Rotate opens the Rotate Screen dialog.

• About - displays a screen with the version of PocketMoney and 
technical support contact information.

View (Register)

• Create Custom Filter... - opens the Custom Filter Screen in order to 
create a new filter. (See “Custom Filters” for further information).

 • Select Custom Filter... - pops up  a list of custom filters that have 
been saved in the Custom Filter Screen.

• Clear Filter - displays all transactions for the current account.

 • Transaction at Date- pops up a date picker and displays 
transactions starting at the selected date in the register.

 • First Transaction - moves to the first record. (Same as moving the 
scroll bar to the very top.)
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 • Last Transaction- moves to the last record. (Same as moving the 
scroll bar to the very bottom.)

 • New Transaction- creates a New transaction and opens the Edit 
Transaction window.

Tools

• Reconcile... - allows you to reconcile the balance of cleared 
transactions against a bank or credit card balance. (See 
“Reconciling Accounts” for further details).

• Rollup Transactions... - used in conjunction with a filter, rolls up 
selected transactions into a single transaction. (See “Rolling Up 
Transactions” for more information).

• Delete Account... - deletes the account displayed in the register.

• Filtered Balance Report - opens the filtered balance screen, which 
sums up the transaction amounts based on the current filter setting. 
(See “Reports On Screen” and “Custom Filters” for further 
information).

• Category Report - generates a report listing amounts spent by 
Category based on current filter setting.

• Payee Report - generates a report listing the amounts paid per 
Payee based on current filter setting.

• Account Report - generates a report listing the amounts paid per 
Account based on current filter setting.
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• Save to Notes - saves the register to the Notes/Memo application.

Record

• New - creates a new transaction.

• Duplicate - makes a copy of the current transaction on the Data 
Entry Slip into a new transaction.  The date will be set to the 
present date & time.

• Beam - beams transaction to PocketMoney on another Palm device.

• New Check # - performs the same functionality as picking New 
Check # from the ID# pop-up.

• Include Fee - performs the same functionality as picking Include 
Fee from the ID# pop-up.

• Edit Repeating - open the repeating transaction dialog box.

Lists

The Lists menu has options to edit the customizable popup lists.
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Hi n t :

View (Account List)

• All Accounts - shows all accounts on the Account List screen.

• Non Zero Accounts - only displays accounts with a non zero balance.

• Total Worth Accounts - only display accounts with the Total 
Worth checkbox checked. 

To limit which accounts are included in the reports: 
View by Total Worth Accounts and check the Total Worth 

checkbox for the accounts you want in the report, 
Tap the Account column heading to view all the transactions 

with the exception of those which are not included in the Total 
Worth calculation.

Report

• Save to Notes - saves the report to the Notes/Memo application.

PocketMoney User’s Manual v.3.0 16



3. 
Samples

Initially, all account balances in PocketMoney are zero. The first step in 
PocketMoney is creating Opening/Starting balances for all your 
accounts. Let’s set up balances for checking and Visa accounts. These 
accounts are the defaults built into PocketMoney, but you can change the 
name of the accounts and add as many other accounts as you need.

Starting Balance for Checking

Let’s create a checking account starting balance of $354.88:

1. Open PocketMoney.

2. Create a Checking Account.
 a. Tap New.
 b. Enter “Checking” in the Account field.
 c. Tap OK.

3. Select “Checking” from the Account listing.

4. Tap New.

5. Set the transaction type to Deposit.

6. Write or key “Miscellaneous” into the Category field.

7. Write or key “Opening Balance” into the From field.

8. Write or key the check number of the last check that you wrote 
into the Id # field. This enables PocketMoney to assign the next 
available check number.

9.  Write or key 354.88 into the Amount field. 

10. Tap OK. This will save the transaction.
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11. Observe that the calculated balance is $354.88. 

Starting Balance for Visa 

Let’s create an unpaid balance in your Visa account of $1,224.69:

1. Tap OK to return to the Account List screen if you are not there.

2. Create a Visa Account.
 a. Tap New.
 b. Enter “Visa” in the Account field.
 c. Set the Type to “Credit Card”
 d. Tap OK.

3. Select “Visa” from the Account listing.

4. Tap New.

5. Set the transaction type to Withdrawal. (This is money you owe.)

6. Write or key “Miscellaneous” into the Category field.

7. Write or key “Opening Balance” into the To field. 

8. Write or key 1224.69 into the Amount field. 

9. Tap OK. This will save the transaction. Tap OK, again, to return 
to Account List.

10. Observe that the calculated balance is $-1224.69. 

PocketMoney User’s Manual v.3.0 18



Transfer Transaction

Let’s enter data for a check to pay your credit card bill:

1. Tap Checking  to open the Checking Register.

2. Tap New.

3. Set the transaction type to Transfer.

4. If the Account name does not appear as Checking, tap the Account 
 and select Checking.

5. Leave the Category blank.

6. Tap on the T To  and select Visa.

7. Tap on the ¨Id # label and then tap Next Check #. The next 
available number appears here. Alternatively, you can write or 
key in a check number.

8. Write or key the amount of the check into the Amount field.

9. Tap OK twice. Observe that the calculated balance of the 
Checking and Visa accounts has been updated to reflect the new 
check.

Withdrawal Transaction

Let’s enter data for a credit card purchase:

1.  Open the Visa register and tap New.

2. The transaction type is already Withdrawal.

3. Tap on the Account  and select Visa. The balance at this point 
reflects the opening balance and the payment that you entered in 
the examples above.
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4. Tap on the Category  and select the appropriate category (e.g., 
Recreation).

5. Write or key the name of the store (e.g., Smuggler’s Notch Ski 
Shop) into the To field. 

6. Write or key the amount of the purchase into the Amount field.

7. Tap OK. Observe that the calculated balance has been updated to 
reflect the new purchase.

8. Optional: Tap the Memo icon and enter information in the Notes 
field (e.g., Snowboard).

Deposit Transaction

Let’s enter data for a paycheck deposit:

1. Open the Checking register and tap New.

2. Set the transaction type to Deposit. Your paycheck increases your 
net worth.

3. Tap on the ¨Category label and select Salary.

4. Write or key the name of your employer (e.g., E. Scrooge) into the 
From field. The next time you enter a paycheck you can select the 
name out of the pop-up list because “Auto-add to popups” is turned 
on in the Prefs.

5. Write or key the amount of the paycheck into the Amount field.

7. Tap OK and observe that the calculated balance has been updated 
to reflect the new deposit.
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Transaction in Foreign Currency

Let’s enter data for a credit card purchase in a foreign country:

1. Turn on Multiple Currencies in the Prefs screen ( ) .

2. Open the Visa register and tap New.

3. Tap on the ¨Category label and select Food.

4. Write or key the name of the restaurant into the To field.

5. Write or key the amount (in foreign currency) of the purchase into 
the Amount field.

6. Enter the current exchange rate in the Rate field. For example, if 
1.33 is the current exchange rate between Canada and the US then 
1.33 Canadian dollars (foreign currency) equals 1 US dollar (base 
currency for account).

Tap the x button to open the Exchange Rate worksheet. The 
Exchange Rate worksheet will lookup the exchange rate from the 
previous record.

7. Tap OK and observe that the calculated balance has been updated 
to reflect the new purchase.
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4. 
Features

Chapters 2 and 3 covered basic transaction entry and navigation. This 
chapter covers all other  PocketMoney features.

List Editor
The editor is how you edit PocketMoney customizable pop-up lists. 
Lists that are editable are: Categories, Payees, ID#s, Amounts, 
Currency Prefix, and Currency Suffix. Use the List Editor as follows:

• Select Edit in the pop-up list to bring up the List Editor so that you 
may add, rename or remove list items.

• To Add an Item to the List, tap New. 

• To Rename an Item, select the item you want to rename and tap the 
Rename button. Enter the new name.

• To Remove an Item from the List, select the item, and tap Delete.

Note: Payees are based on the currently selected category so the list 
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will only show items for the current a category. 

Note: To enter sub-categories and sub-sub-categories you must separate 
them by a colon (:).  (IE: Utilities:Gas or Utilities:Electric)

Category Splits

The category pop-up has a choice called <—Splits—>:

Select <—Splits—> to activate the Splits screen or tap on the category 
label open the Splits window.

exchange
rate

memo/class

Category/
Transfer
popup

+/- button

Splits allow entry of up to 255 categories with varying amounts for a 
single transaction.  Enter negative amounts if you want to take out taxes 
from a deposit for you salary.

•!Adjust - sets the transaction’s overall Amount to the Splits Total’s 
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amount.

•!Clear  - removes all of the splits entered for this transaction.

•!Category/Transfer popup - click the popup to choose between 
category or transfer. Selecting category opens a category picker. 
Selecting transfer opens an account picker.

•!Memo/class - opens the memo screen which also allows the setting 
of the class for the individual split item.

•!Exchange rate - opens the exchange rate worksheet to set the 
exchange rate for an individual split item.

•!+/-  sign - toggles the amount from negative to positive. Negatives 
amounts take away money from the account. Positive amounts add 
money to the account.

Note: If there is a Remainder after you have entered all of the amounts 
you either need to add the remainder on the last line or you should 
Adjust the total for the transaction. 

Preferences

The PocketMoney Preferences screen is accessed from the Options menu 
:
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It includes the following items:

• Home Currency - defines the default currency that all new accounts 
use. It also is the currency format used to calculate the Total 
Worth. Tap the Home Currency amount to change the default 
currency.

• Multiple currencies - specifies use of multiple currencies. Check the 
check box to allow the use of multiple currencies.

• Auto-add categories & payees - determines the behavior of the 
pop-ups automatically. Check the check box to add any new 
category or payee  to the pop-up lists. 

• Hide Register Scrollbar - hiding the scrollbar can speed up the 
transaction display in the register view. Use the up and down 
scroll arrow buttons to scroll the data in the register view.

• Color banding in register - turn on color use in register and account 
list screen. Set the color of the rows with the Set Row Color in the 
Options menu. 

Note: Color banding causes the screen to draw slowly on some devices. 
Uncheck Color Banding to speed these devices up.

• Recur X days in advance - enter the number of days in ahead of the 
scheduled repeating transaction time to add the repeating 
transaction to the register. This allows you to see what bills are 
upcoming. 

• Password - enter 1 to 4 digits for a password. To remove the 
password erase it. PocketMoney will ask for a password whenever 
it is launched. 

• Disable password on power on - some applications conflict with 
PocketMoney’s password feature. Checking this option avoids the 
conflict by preventing PocketMoney from displaying the password 
screen after a power on. 
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Account Info

The Account Prefs screen allows you to supply detailed information 
about particular accounts and set default values and behavior for those 
accounts.

It includes the following data items:

• Account - name as appears in the Account lists. Write in the name 
of the new account.

• Type - defines a particular type of account, such as bank, cash, or 
credit card. Tap the Account Type   and then tap the desired type.

• Exp - is displayed when Type is Credit Card or Bank. This allows 
you to write in an expiration date for your credit card, for reference.

• Account # - defines an account number, for reference.

• Institution - defines the name of the institution who issued the 
account, for reference.

• Phone # - defines a phone number for the institution, for reference. 

• Transaction fee - accepts a numeric value to use in conjunction with 
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the Include Fee option on the Data Entry Slip Id # field. Write in a 
value.

• Fixed or Percent - determines how the Transaction Fee is applied. 
Tap the Fixed  or Percent  to select a fixed value added to the 
transaction amount or as percent of the transaction amount. For 
example, 1.00 as a fixed amount means one dollar. 1.00 as a percent 
amount means 1 percent.

• Limit - accepts a numeric value to represent the account’s minimum 
balance or credit limit requirements, if any. For Bank and Cash 
types of accounts PocketMoney warns you if your balance ever falls 
below this amount. For Credit Card accounts PocketMoney warns 
you if your balance ever exceeds this amount. Leave Limit blank if 
you do not want to be warned. Write in a value to set the limit.

• Chk# - accepts a numeric value which is the next check number.

• Exchange Rate - displays the exchange rate and currency format for 
the selected account. Tapping it opens the Currency & Conversion 
Rate editor.

Prefix - is the symbol that appears before the amount.

Suffix - is the symbol that appears after the amount.

Decimal Places - specifies the number of decimal places in the 
currency. For example Japanese Yen have zero decimal places.

Rate - is the amount of this currency that is equal to 1 unit of 
the Base Currency. Base Currency is set in Prefs.

• Total Worth -determines whether this account’s balance is added 
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to the Total Worth calculation in the Account List screen. Check 
the check box to include this account in the Total Worth 
calculation.

• Notes - allows space for miscellaneous information for the account. 

Creating a New Account
From the Account List screen tap . This opens a new Account Info 
screen for you to name and enter the details for the new account.

Deleting an Account
Tap  to delete all information for the displayed account. 
PocketMoney asks you to confirm the deletion.

Note: Deleting the account deletes all transactions associated with 
that account.

On Screen Reports

The Tools menu provides access to PocketMoney’s reports. The Tools 
menu is accessible from the Register screen.

Filtered Balance Report

The Filtered Balance report sums up all transactions based on the 
current filter setting. This feature allows you to get a balance for a 
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current set of data. For example, if you set the custom filter category to 
Food, Filtered Balance gives the total that you have spent on food in 
all of your accounts. Refer to “Custom Filters” for further information.

Category Expenses

Category Expenses displays the amount of money spent broken down by 
category. You can define the scope of the report by setting the filter. 
Refer to “Custom Filters” for further information.

Payee Expenses

Payee Expenses displays the amount of money spent broken down by 
payee. You can define the scope of the report by setting the filter. Refer 
to “Custom Filters” for further information.

Account Expenses

Account Expenses displays the amount of money spent broken down by 
account. You can define the scope of the report by setting the filter. 
Refer to “Custom Filters” for further information.

Custom Filters

Filters are a powerful way to display and report on subsets of 
transactions. PocketMoney dynamically updates the views of the data 
represented by the currently selected filter every time the screen is 
redrawn.
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From the Register screen tap Menu and select Create Custom Filter from 
the View menu or write .

Pick which items you would like displayed:

• Trans (action) - allows selection of Deposit, Withdrawal,Transfer,  
All Transactions, and Repeating Transaction to include in the 
filter. Tap the Transaction  and select the transaction 
classification.

• Account - allows selection of particular account to include in the 
filter. Tap the Account  and select the account.

• Class - allows selection of particular class to include in the filter. 
Tap the Class  and select the Class.

• Category - allows selection of particular category to include in the 
filter. Tap the Category  select tap the category. The filter 
matches any category that starts with what is entered. If 
“Utilities” is entered then “Utilities:Phone” and 
“Utlities:Electric” are displayed. 

• To/From - allows selection of particular payee or source to include 
in the filter. Tap the To/From  and select or write the item.

• ID#  - allows selection of particular ID# type to include in the 
filter. Entering “ATM#” will show all entries that begin with 
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Hi n t :

“ATM#”. Tap the ID#  and select or enter the item.

• (Dates) From - allows selection of a start date to include in the 
filter. Tap the From  to bring up the Date Editor.

• (Dates ) To - allows selection of ending date to include in the filter. 
Tap the To  to bring up the Date Editor.

Two special cases for Date To and Date From are:

Today: If selected PocketMoney will replace “Today” with the 
current date whenever the filter is evaluated.

1st of Month : If selected PocketMoney will replace “1st of Month” 
with the first day of the current month. For example, if today is 
May 12, 2000 then PocketMoney will use May 1, 2000.

• Cleared - allows selection of cleared/uncleared status to include in 
the filter. Tap the Cleared  and select the cleared status setting 
(Yes/No/Doesn’t matter). 

• Recent - checking this will show only items that have changed 
since the last upload. 

Several buttons at the bottom of the filter screen determine the 
disposition of the filter conditions:

• Tap Set to set the filter as defined in the Filter screen.

• Tap Cancel to close the Filter Conditions screen and leave the 
filter unchanged.

• Tap Save to save the filter conditions with a name that you 
choose. That name now appears in the Custom Filter pop-up when 
you select the “Select Custom Filter...” option in the View menu.

• Tap Remove... to delete a previously saved filter.
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Note: If you change a transaction value that does not conform to the 
current filter, the transaction will not appear in the Register Screen 
when you close the Data Entry Slip.
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Reconciling Accounts

Reconcile an account as follows:

1. Mark transactions that appear on your bank or credit card 
statement by checking the cleared box on the Overview Screen or 
the Data Entry Slip. You may want to enter transactions from your 
statement that have not already been entered into PocketMoney.

2. Tap Menu and select “Reconcile...” from the Tools menu.

3. Enter the balance from your bank or credit card statement on the 
input line. Remember that liability accounts such as credit cards 
and loans have a negative balance, and you should enter a negative 
amount on the input line to reconcile these types of accounts.

4. Tap Cleared. Cleared reconciles the account based upon cleared 
transactions only. 

Note: The All Transactions choice allows reconciling of accounts that 
include cleared and uncleared transactions. This is useful for reconciling 
your Pocket/Cash accounts.

5. Tap Reconcile.

6. PocketMoney calculates how much must be posted to the account to 
reconcile it and prompts you to post x dollars to the account to 
reconcile it. Tap OK to create a reconciliation transaction. 
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Rolling Up Transactions 

Rollup works as a function to delete all found transactions. It deletes all 
the transactions found by the current filter and adds one transaction to 
take their place. Because it deletes many transactions, this is NOT 
REVERSIBLE, so be certain this is what you want to do.

This feature is useful for users who want to use PocketMoney to track 
transactions on the road and use a PC or Macintosh-based financial 
program to track data the rest of the time. You can export PocketMoney 
data to your desktop program and then choose Rollup Items to remove 
all the transactions exported. This way, the next time you export you 
will not get duplicate transactions.

This feature used in conjunction with a Custom Filter can be used to 
Rollup all transactions from last year. This allows  you to keep only the 
most recent data in PocketMoney thereby saving storage space.

Rollup a set of transactions as follows:

1. Create a filter to select the transactions you want to rollup. (See 
“Custom Filters” for more information).

2. Tap Menu and select Rollup Transactions... from the Tools menu.

3. The found transactions are counted along with the number of 
transfers. 

Note: Transfers are rolled up by breaking the other end of the transfer 
into a withdrawal or deposit.

4. Tap to confirm that you want to rollup the found transactions.

5. PocketMoney will remind you that this action is NOT 
REVERSIBLE. If you still want to rollup all items, tap OK.
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Recompute Balances

You must recompute balances if you modify your PocketMoney data from 
an external source or if PocketMoney runs out of memory before it can 
save a transaction and update the account balance which will result in 
incorrect balances.

To recompute balances, tap Menu and select Recompute Balances from 
the Options menu.

Repeating Transactions/
Standing Orders
If transactions occur on a regular basis (paychecks, rent, car payments,..)  
can be automatically entered by PocketMoney. 

Tap the Repeating Transaction Button on the Edit Transaction screen 
top open the following screen.

Set how often you want the transaction to repeat and tap OK. 
PocketMoney creates a repeating transaction with the current 
transaction’s account, category, payee, amount, cleared checkbox, and 
memo. 

Note: If you go back and change any values in the transaction the 
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repeating transaction values will also be changed. The exception to this 
is if you check the cleared checkbox in the register view. This allows 
you to create a transaction that has not yet been cleared , have it repeat 
as an uncleared transaction and then check it off as cleared when you 
reconcile PocketMoney with your bank  statement each month.

You cannot create a repeating transaction with the amount blank and 
fill it in when you pay the bill. An example would be the electric or 
telephone bill that will be about the same price every month, but will 
vary by a few dollars. For this sort of repeating transaction you should 
make it a repeating transaction and correct the amount each month. 
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5. 
Interfacing 
PocketMoney with 
Desktop Applications

PocketMoney supports importing and exporting of transactions via the 
PocketMoney Conduit.  There  are Macintosh and Windows conduits for 
PocketMoney. 

Installing Macintosh Conduit

1. Copy “PocketMoney Conduit” to the Conduits folder located in the 
Palm Desktop folder.

2. Hotsync so the PocketMoney conduit can create the directories in your 
user directory. 

Installing Windows Conduit

1. Run the PocketMoney.exe installer. It installs everything you need to 
use the conduit. If everything installed correctly then you should see 
PocketMoney in the custom settings listing.

2. Hotsync so the PocketMoney conduit can create the directories in your 
user directory. 
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Import and Export Formats

There are two file formats the Conduit can upload: TDF and QIF. These 
two types cover the most common importing and exporting formats.

Tab-delimited format (TDF) - standard format for interchanging data 
with databases and spreadsheets. Some desktop personal finance 
programs will import and export TDF files.

Quicken Interchange Format (QIF) - special file format developed by 
Intuit for use with Quicken. Most desktop personal finance programs 
(MS Money, Mac Money, Quicken, and others) can import QIF files. 
Some, but not all desktop finance programs export QIF files.

Conduit Settings

Access to the PocketMoney Conduit Setting is different on the 
Macintosh and Windows platforms. 

Macintosh: Open the HotSync application, choose Conduit Settings 
from the HotSync menu, double click the PocketMoney line to open the 
PocketMoney Conduit Settings window.

Windows: Click the HotSync button in the System Tray, select Custom, 
double click the PocketMoney line to open the PocketMoney Conduit 
Settings window.
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HotSync Direction
• Update Handheld from Desktop - checking this will download 

data located in the PocketMoney/ToPalm folder to PocketMoney on 
the Palm.  

The conduit downloads data from any file in the ToPalm with the 
.qif or .tdf extension depending on the File Format specified. If the 
Account is not specified in the QIF file then the file name will be 
used as the account name. 

• Update Desktop from Handheld - checking this will upload data 
located from PocketMoney on the Palm device to a file called 
“PocketMoney.qif” or “PocketMoney.tdf” located in the 
PocketMoney/FromPalm folder.  

• Upload All Transactions - checking this will upload all 
transactions from PocketMoney, the current PocketMoney.qif/.tdf 
file will be deleted before uploading the data. 

Leaving this unchecked will only upload transactions that have 
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been changed since the last HotSync, the data will be appended to 
the current PocketMoney.qif/.tdf  file.  Since, the data is not 
deleted it is up to the user to delete the file after it has been 
imported into a desktop financial program.

• Purge Deleted Transactions - check this to permanently delete 
transactions from PocketMoney on the handheld. Transactions are 
only marked for deletion in order for IR Sync to update, delete, and 
add transactions during the IR Sync process. Deleted transactions 
continue to use memory so occasional purging is recommended.  

This option should be checked if the IR Sync feature is not used. 

If the IR Sync feature is used then this option must be unchecked. It 
is recommended that once per year to purge deleted transaction. IR 
Sync the Palms to synchronize the data, then check this option and 
HotSync to purge the deleted transactions to free memory on the 
Palm device.

File Format
• QIF - select this format if you will be exchanging data with 

Quicken (version 7 or newer), Mac Money, or other finance programs 
that support the Quicken Interchange Format.

• QIF-Old - select this format if you will be exchanging data with 
MS Money, Quicken (version 5 or older), or other finance programs 
that support the Quicken Interchange Format.

  
• TDF - select this format if you will be exchanging data with 

spreadsheets, databases, or other programs that support Tab 
Delimited Format files.

  
Date Format
Choose the date format that of the data you will be importing and the 
format you want to export your data as.

Separator determines what symbol is used to separate the date. 
mm/dd/yyyy, mm-dd-yyyy, or mm.dd.yyyy.

Number Format
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Choose the number format that of the data you will be importing and 
the format you want to export your data as.

Exchanging Data

Upload from Palm to Desktop: After you set all of the settings in the 
PocketMoney Conduit Settings window then you can HotSync.  When 
HotSync is completed either a PocketMoney.qif or PocketMoney.tdf file 
will be located in the FromPalm folder. 

Refer to the user manual of your finance or other desktop program for 
importing and exporting data. 

Downloading from Desktop to Palm: Export the data from your finance 
or spreadsheet program. Move the file to the ToPalm folder. HotSync. 
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HotSync Scenarios
There are a few different scenarios for keeping your desktop and 
PocketMoney data up to date. PocketMoney is flexible which means 
that not all users use PocketMoney in the same way. Personally, I use 
PocketMoney as my main finance program and I uploaded to Quicken 
between one and four times a year. Some people update their desktop 
program every week. Others use the desktop as their main finance 
program because they might pay bills online and want PocketMoney to 
capture transactions while they are on the go. And, there are a variety 
of ways in-between.

Desktop is Main & PocketMoney Mirrors
If your desktop finance program is your main program, but you want 
PocketMoney to mirror your desktop program then the easiest way to do 
this is to:

1. Hotsync PocketMoney with ‘Upload All Transactions’ unchecked.
2. Import PocketMoney.qif/tdf into your finance program. Delete the 
PocketMoney.qif/tdf file or  duplicate transactions will be created on 
the next Import.
3. Pay your bills, print checks, and perform any online banking from 
your desktop program. (This step could also happen as step 1.)

Now, you have two choices  (4A&4B) depending on how  much control 
your desktop program has in exporting data.

4B If your desktop program can export the transactions that you have 
recently entered on the desktop then export those new transactions. The 
next HotSync will import the new transactions from the desktop which 
had not been entered in PocketMoney, yet.

4B If exporting only the new transactions in the desktop program is not 
an option then you can export all of the accounts and have PocketMoney 
import everything. Before you HotSync you need to delete all of the 
accounts from PocketMoney. The easiest way to do this is it to tap the 
Account Info  button next to the account name to open the Account Prefs 
screen. Tap Delete to delete the account and all of the transactions. 
Repeat this for all of the accounts you will be downloading from the 
desktop.
5. HotSync.
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Desktop is Main & PocketMoney Balances 
If you are only concerned about keeping the balance updated in 
PocketMoney and do not need every transaction in PocketMoney that is 
entered in your desktop finance application then the process is a 
simpler.

1. Hotsync PocketMoney with ‘Upload All Transactions’ unchecked.
2. Import PocketMoney.qif/tdf into your finance program.
3. Pay your bills, print checks, and perform any online banking from 
your desktop program. (This step could also happen as step 1.)
4. Select an account to go to its account register.
5. Choose ‘Reconcile’ from the Tools Menu. Enter the balance from the 
desktop application for this account. Tap ‘Reconcile’ and PocketMoney 
will post an adjustment to this account. 
6. Repeat step 5 for all account balances that need to be changed.

PocketMoney is Main & Desktop Mirrors
This is the scenario I use because I always have my Palm with me, but I 
rarely have my desktop with me. PocketMoney is my main finance 
application, but a few times a year I upload to my desktop application 
to generate some graphs or reports that I can’t generate in PocketMoney.

1. Hotsync PocketMoney with ‘Upload All Transactions’ checked.
2. Import PocketMoney.qif/tdf into your finance program.
3. Generate graphs or run reports in desktop application.
4. Uncheck Update Handheld and Update Desktop so PocketMoney is 
skipped during the subsequent HotSyncs. This speeds up HotSyncing by 
skipping PocketMoney.

Multiple Users: Multiple HotSync Option
If multiple people are using PocketMoney and HotSycing to the desktop 
then import the PocketMoney.qif/tdf files into your main desktop 
finance application and follow the directions for Desktop is Main & 
PocketMoney Mirrors or Desktop is Main & PocketMoney Balances.
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Multiple Users: IR Sync Option

If you and your spouse both use PocketMoney then the IR Sync option is 
the preferred way to keep your accounts in PocketMoney in sync because 
you can synchronize at any time you both have your Palm devices 
handy.

IR Sync in 3.0 works with IR, Bluetooth, SMS, and other Palm OS 
supported exchange protocols.

All Accounts 
If you and your spouse share your checking, savings, and credit card 
accounts and to have PocketMoney in sync on both Palms then 
PocketMoney’s IR Sync option makes it easy.

1. Spouse #1 opens to the Account List screen. 
2. Spouse #1 chooses IR Sync from the Options menu to beam transactions 
Spouse #2.
3. Spouse #2 accepts the incoming beam.
4. Spouse #2 performs steps 1 & 2.

Selected Accounts
If you and your spouse share some accounts, but not all of your accounts 
then you need to do a couple extra steps. For example, you might have a 
private checking account and you don’t want your spouse to know what 
you bought him/her for Christmas so you don’t want to send that 
account data.

1. Spouse #1 opens the account register that you want to sync.
2. Spouse #1 chooses IR Sync from the Options menu to beam  
transactions to Spouse #2.
3. Spouse #2 accepts the incoming beam.
4. Spouse #2 performs steps 1 & 2.
5. Repeat steps 1-4 for all of the other accounts.

Selected Transactions
Sort of like Selected Accounts, but with more control. Create a Custom 
Filter for only the data you want to exchange. Any data being viewed 
will be beamed. Follow steps in Selected Accounts, but instead of 
opening an account register, you want select the custom filter criteria.
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